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+ “Simscape Multibody Link Product Description” on page 1-2
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+ “Install the Simscape Multibody Link Plug-In” on page 1-5
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Simscape Multibody Link Product Description
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Export CAD assemblies for use in Simscape Multibody software

Simscape Multibody Link is a CAD plug-in for exporting CAD assemblies from
SolidWorks®, Autodesk Inventor®, and PTC® Creo™ software. The plug-in generates an
XML file detailing the structure and properties of your CAD assembly and 3-D geometry
files for visualizing the various CAD parts. You can then import the files into Simscape
Multibody software, which parses the XML data and automatically generates an
equivalent multibody model.



Related Products

Related Products

In this section...

“Required Products” on page 1-3
“Other Related Products” on page 1-3

Required Products
Simscape Multibody Link software requires MATLAB® software.
Supported Operating Systems

You can use the Simscape Multibody Link product on any operating system that supports
MATLAB.

Supported CAD Platforms
To build and export CAD assemblies, you need a CAD platform. Such a platform must

either be supported directly by the Simscape Multibody Link utility or have an API you
can use to write a custom Simscape Multibody Link interface.

Other Related Products

Simscape Multibody Product

Note The Simscape Multibody Link utility does not require the Simscape Multibody,
Simscape, or Simulink® products.

The XML multibody description and body geometry files exported by the Simscape
Multibody Link utility are intended for use with the Simscape Multibody product.

Physical Modeling Product Family

Use the Physical Modeling product family to model physical systems in Simulink. In
addition to Simscape Multibody software, it includes:

Simscape the platform and unifying environment for Physical Modeling products

1-3
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+  Simscape Driveline™ for modeling and simulating drivetrain systems
+  Simscape Electronics™ for modeling and simulating electronic systems
+  Simscape Fluids™ for modeling and simulating hydromechanical systems

+  Simscape Power Systems™ for modeling and simulating electrical power systems



Install the Simscape Multibody Link Plug-In

Install the Simscape Multibody Link Plug-In

In this section...
“What is Simscape Multibody Link?” on page 1-5
“Alternatives to Simscape Multibody Link” on page 1-5

“Before You Begin” on page 1-6

“Step 1: Get the Installation Files” on page 1-6

“Step 2: Run the Installation Function” on page 1-6

“Step 3: Register MATLAB as an Automation Server” on page 1-7
“Step 4: Enable the Simscape Multibody Link Plug-In” on page 1-7

What is Simscape Multibody Link?

Simscape Multibody Link is a plug-in that you install on your CAD application to export
your CAD assembly models. The plug-in generates the files that you need to import the
model into the Simscape Multibody environment (using the smimport function). You can
install the plug-in on three CAD applications:

+  SolidWorks

* Autodesk Inventor
+ PTC Creo

Alternatives to Simscape Multibody Link

You can export an assembly model from Onshape® CAD software using the
smexportonshape function. This function generates the same files as the Simscape
Multibody Link plug-in—one an XML multibody description file, the rest a set of body
geometry files.

If you use a different CAD application, you can create a custom application based on the
published Simscape Multibody XML schema. This approach requires some knowledge of
XML. See the schema web page for an example.

If you can export a multibody model in URDF format, then you can also import that
model using the smimport function. This approach may suit you if your CAD application
1s not among those supported and you have little experience with XML schemas.

1-5
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Before You Begin

You must have a valid MATLAB license and one of the supported CAD applications:

+ Autodesk Inventor software
+ PTC Creo software
+  SolidWorks software

Your MATLAB and CAD installations must have the same system architecture—e.g.,
Windows 64-bit.

Step 1: Get the Installation Files

1  Go to the Simscape Multibody Link download page.
2 Follow the prompts on the download page.
3 Save the zip archive and MATLAB file in a convenient folder.

Select the file versions matching your MATLAB release number and system
architecture—e.g., release R2015b and Win64 architecture. Do not extract the zip
archive.

Step 2: Run the Installation Function

1  Run MATLAB as administrator.
2 Add the saved installation files to the MATLAB path.

You can do this by entering addpath (' foldername') at the MATLAB command
prompt. Replace foldername with the name of the folder in which you saved the
installation files—e.g., C: \Temp.

3 At the MATLAB command prompt, enter install addon('zipname').

Replace zipname with the name of the zip archive—e.g.,
smlink.r2015b.win64.zip.


http://www.mathworks.com/products/simmechanics/download_smlink.html

Install the Simscape Multibody Link Plug-In

Step 3: Register MATLAB as an Automation Server

Each time you export a CAD assembly model, the Simscape Multibody Link plug-in
attempts to connect to MATLAB. For the connection to occur, you must register
MATLAB as an automation server. You can do this in two ways:

In a MATLAB session running in administrator mode — At the command prompt,
enter regmatlabserver.

In an MS-DOS window running in administrator mode — At the command prompt,
enter matlab -regserver.

Step 4: Enable the Simscape Multibody Link Plug-In

Before you can export an assembly, you must enable the Simscape Multibody Link plug-
in on your CAD application. To do this, see:

“Enable Simscape Multibody Link Inventor Plug-In”
“Enable Simscape Multibody Link Creo-Pro/E Plug-In”
“Enable Simscape Multibody Link SolidWorks Plug-In”

1-7
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“CAD Translation” on page 2-2
“Export a CAD Assembly Model” on page 2-12
“Troubleshoot CAD Export Issues” on page 2-14
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In this section...

“Translating a CAD Model” on page 2-2
“What’s in a Translated Model?” on page 2-3
“What’s in a Data File?” on page 2-6
“Exporting a CAD Model” on page 2-7
“Importing a CAD Model” on page 2-8
“Simplifying Model Topology” on page 2-9
“Updating an Existing Data File” on page 2-10

Translating a CAD Model

You can translate a CAD model into an equivalent Simscape Multibody block diagram.
The conversion relies on the smimport function featuring an XML multibody description
file name as its central argument. The XML file passes to Simscape Multibody software
the data it needs to recreate the original model—or an approximation of it if unsupported
constraints exist in the model.

You translate a CAD model in two steps—export and import. The export step converts
the CAD assembly model into an XML multibody description file and a set of STEP or
STL part geometry files. The import step converts the multibody description and part
geometry files into an SLX Simscape Multibody model and an M data file. The model
obtains all block parameter inputs from the data file.




CAD Translation

Import

/-4 Block Parameter Data File
Export
Assembly

/-( Multibody Description File -i'
/ \-4 Simscape Multibody Model
\ { Part Geometry Files

CAD Translation Steps

What's in a Translated Model?

The translated model represents the CAD parts—referred to as bodies in Simscape
Multibody software—using Simulink subsystems that comprise multiple Solid and Rigid
Transform blocks. The Solid blocks provide the body geometries, inertias, and colors. The
Rigid Transform blocks provide the frames with the required poses for connection
between bodies.

i

Consider the upper arm body of a CAD robotic arm model, shown in the figure. The
Simulink subsystem for this body consists of one Solid block connected to a pair of Rigid
Transform blocks. The Solid block provides the reference to the upper arm geometry file
and the inertial properties derived from the CAD model. The Rigid Transform blocks
provide the frames for connection to the robot base and lower arm bodies.

2-3



2 caD

Export

-

Saolid

[]

=

#

ReferenceFrame

5 Fx
1=

o]

Transform

Simulink Subsystem Representing Upper Arm Body

CAD joints, constraints, and mates translate into Simscape Multibody software as
combinations of joint and constraint blocks. In the CAD robotic arm example, the
constraints between the upper arm and the lower arm translate into a Revolute Joint
block. This block sits between the Simulink Subsystem blocks that represent the upper
arm and lower arm bodies.

Constra

Represents:
nt

Part

Part Constraint Part

4
[Fl—&—F1 B, 'fﬂ\‘f

ffx) =0

6] Fi FE—EE ._ﬁi' F E—E Fi Fi FE-
Rigid Transform Base Spherical Joint Upper Arm Rewolute Joint Lower Arm
Block Part Block Part Block Part
b
Represents:
Constraint Part traint 5
—E|Ex (_-j:EI—EF F1 H_EEH::j:El—EF
Revolute Joint Wist Rewolute Joint Grip
Block Part Block Subassembly

Simulink Subsystem Representing Upper Arm Body



CAD Translation

By default, the translated model preserves the structural hierarchy of the original CAD
model. If the source model is a CAD model with multibody subassemblies, the
subassemblies convert in Simscape Multibody software into multibody Simulink
subsystems. Consider again the CAD robotic arm model. The model contains a grip
multibody subassembly with seven bodies, shown schematically in the figure.

[#] Rebot Arm CAD Assembly Model
— Base Part

— Upper Arm Part

—= Lower Arm Part

— Wrist Part

[prn|

b| Grip Multibody Subassembly
—= Metacarpals Part

—* First Finger Link Part

—=* First Finger Link Part

—* Second Finger Link Part
—= Second Finger Link Part

—=* Finger Tips Part

—= Finger Tips Part

CAD Robotic Arm Model Hierarchy

During translation, the grip subassembly converts into a Simulink subsystem with seven
Simulink subsystems, one for each body.
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What's in a Data File?

Blocks in the translated model are parameterized in terms of MATLAB variables defined
in the data file. These variables are stored in structure arrays named after the various
block types. The structure arrays are nested in a parent data structure named smiData
or a custom string that you specify.

Consider an imported model with a data structure named smiData. If the model
contains Revolute Joint blocks, the parameter data for these blocks is the structure array
smiData.RevoluteJoint. This structure array contains a number of data fields, each
corresponding to a different block parameter.

The structure array fields are named after the block parameters. For example, the
position state target data for the Revolute Joint blocks is in a field named



CAD Translation

Rz _Position Target. If the model has two Revolute Joint blocks, this field contains
two entries—smiData.RevoluteJoint (1) . Rz Position Target and
smiData.RevoluteJoint (2) .Rz_Position target.

Each structure array index corresponds to a specific block in the imported model. The
index assignments can change if you regenerate a data file from an updated XML
multibody description file. The smimport function checks the prior data file, when
specified, to ensure the index assignments remain the same. See “Updating an Existing
Data File” on page 2-10.

Exporting a CAD Model

You can technically export a CAD assembly model from any CAD application. The
Simscape Multibody Link CAD plug-in provides one means to export a model in a valid
XML format. The plug-in is compatible with three desktop CAD applications:
SolidWorks, PTC Creo, and Autodesk® Inventor®. The plug-in generates not only the
XML multibody description file but also any geometry files required for visualization in
the final translated model.

The Simscape Multibody smexportonshape function provides another means to export
a CAD model, from a cloud application named Onshape. This function exports in a
format compatible with the newer Simscape Multibody blocks only. See “Onshape
Import” (Simscape Multibody) for more information on exporting (and importing) CAD
models from an Onshape account.

If you use an unsupported CAD application, you can create a program that uses the CAD
API and Simscape Multibody XML schema to generate the multibody description and
part geometry files. This task requires knowledge of XML documents, XSD schema
definitions, and CAD APIs. See the schema website for the XSD schema definitions. See
MATLAB Central for an example program built on the SolidWorks CAD API.

If a URDF converter exists for your CAD application, you may be able to export your
model in URDF format and import the URDF file into the Simscape Multibody
environment. Note, however, that the URDF specification forbids closed-chain model
topologies, such as those of four-bar linkages and gear assemblies. For more information,
see “URDF Import” (Simscape Multibody).

A Note About Export Errors

If the Simscape Multibody Link plug-in cannot export a part geometry file or translate a
CAD constraint set, the software issues an error message. The error message identifies
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the bodies with missing geometry files and any unsupported constraints. You can import
the generated XML multibody description file into Simscape Multibody software, but the
resulting model may not accurately represent the original CAD assembly model.

Importing a CAD Model

You import an XML multibody description file using the Simscape Multibody smimport
function in its default import mode. The function parses the file and generates a
Simscape Multibody model and associated data file. For step-by-step instructions on to
import a CAD assembly model via its XML multibody description file, see “Import a CAD
Assembly Model” (Simscape Multibody).

Note Starting with software version R2017b, the Simscape Multibody Link plug-in
exports in an XML format compatible only with Simscape Multibody Second Generation
software. You must import all such XML files using the smimport function. Models
generated with this function comprise only second-generation blocks—those accessible by
entering the command sm 1ib at the MATLAB command prompt.

However, if you have any older XML files in a format compatible with Simscape
Multibody First Generation software, you can continue to import them using the

mech import function. Models generated with this function comprise only first-
generation blocks—those accessible by entering the command mechlib at the MATLAB
command prompt.

CAD Import Errors

If a part geometry file is invalid or missing, the corresponding body cannot show in the
Simscape Multibody visualization utility. If a CAD assembly model contains an
unsupported constraint combination between bodies, Simscape Multibody software joins
the bodies with a rigid connection. The rigid connection can take the form of a direct
frame connection line, Rigid Transform block, or Weld Joint block.
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Rigid Connection Due to Unsupported Constraints

If Simscape Multibody software cannot translate a CAD constraint combination, it issues
a warning message on the MATLAB command window identifying the affected bodies
and their connection frames. For example:

Warning: The set of constraints between upperarm 1 RIGID and forearm 1 RIGID
could not be mapped to a joint. A rigid connection has been added between port F
of upperarm 1 RIGID and port F1 or forearm 1 RIGID for these constraints.

Simplifying Model Topology

You can import a CAD model with a simplified topology. So that you can do this, the
smimport function provides the ModelSimplification argument. You can set this
argument to:

* bringJointsToTop to group each set of rigidly connected parts into a new
subsystem and promote all joints to the top level of the model hierarchy.

* groupRigidBodies to group rigidly connected parts into subsystems (and leave
joints in their original places in the model hierarchy).

2-9
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* None to import the model as is, without simplification.

Use the bringJointsToTop or groupRigidBodies option if your CAD model has many
rigidly connected components, such as nuts and bolts, that you prefer to group together—
for example, to more intuitively grasp the key components of the model at a glance of the
block diagram.

Use the bringJointsToTop option if your CAD model has joints inside subassemblies
and you prefer to expose them at the top level—for example, to work with joint actuation
and sensing signals without having to search for the joints inside different subsystems.

Note that model simplification is available for CAD import only. URDF models have flat
topologies with little need for topology simplification.

Updating an Existing Data File

You regenerate the data file for a previously imported model by running the smimport
function in dataFile mode. You specify this mode using the optional ImportMode
Name, Value pair argument. The function uses the prior data file to keep the mapping
between structure array indices and blocks consistent.

Before regenerating a data file, you must export a new XML multibody description file
from the updated CAD assembly model. The smimport function uses the data in the new
multibody description file to generate the new data file.

The function does not update the block diagram when run in dataFile mode. If you add
or delete bodies in the source CAD assembly model, you must manually add or delete the
corresponding blocks in the previously imported model.
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Export a CAD Assembly Model

In this section...

“Installing and Enabling the Plug-In” on page 2-12
“Accessing the CAD Export Menu” on page 2-12
“Opening a CAD Model Example” on page 2-12
“Export Model” on page 2-13

“After Export” on page 2-13

Installing and Enabling the Plug-In

If you have not yet installed and enabled the Simscape Multibody Link plug-in on your
device, before continuing see “Install the Simscape Multibody Link Plug-In” on page 1-5.

Accessing the CAD Export Menu

You can access the export menu from the CAD application menu bar whenever a CAD
assembly model is open. The location of the menu can vary with the CAD software
version but it is generally under Add-Ins for Autodesk Inventor software and under
Tools for PTC Creo and SolidWorks software.

Opening a CAD Model Example

Your Simscape Multibody Link installation comes with a number of CAD assembly
models that you can use as export examples. You can find the models in the folders:

matlabroot\toolbox\physmod\smlink\smlinkdemos\cadPlatform\modelFolder

Replace the following as described:

*  matlabroot — MATLAB root folder, for example, C:\Programs\MATLAB\. Use the
matlabroot command at the MATLAB command prompt to determine your
MATLAB root folder.

* cadPlatform is an identifier for your CAD application—inventor for Autodesk
Inventor, proe for PTC Creo, and sw for SolidWorks.

2-12
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*  modelFolder is the model name or abbreviation—robot for a robotic arm model and
stewart for a Stewart platform model (available only for SolidWorks and PTC Creo
applications). Ignore the remaining folders.

For example, if your MATLAB root folder is C: \Programs\MATLAB, your CAD
application is SolidWorks, and the model that you’d like to open is robot, then you can
open the mode from the folder:

C:\Programs\MATLAB\toolbox\physmod\smlink\smlinkdemos\sw\robot

Export Model

1  Open the assembly model to export. Note that part models are not supported and
that the Simscape Multibody Link export menu is not accessible if an assembly
model is not open.

2 From the CAD export menu on page 2-12, select the option to export the model.

3  Specify the XML multibody description file name and folder. The Simscape
Multibody Link plug-in generates the XML file and the part geometry files needed to
render the model once imported.

After Export

Use the smimport function with the name of the XML multibody description file as an
argument to import the CAD assembly into the Simscape Multibody modeling
environment. The function parses the file and uses the data contained therein to
generate a Simscape Multibody block diagram and an accompanying MATLAB data file.
See “Import a CAD Assembly Model” (Simscape Multibody).

Warning This content refers to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided. To prevent
compatibility issues in future releases, the Simscape Multibody Link plug-in no longer
supports the translation of CAD models into Simscape Multibody First Generation
models.
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During CAD export, Simscape Multibody Link can encounter CAD translation issues
that arise from unsupported CAD elements. The following issues are known.

Unsupported Constraints

If a CAD assembly contains one or more unsupported constraints or mates, the Simscape
Multibody Link utility issues a warning message and creates a log file in the folder of the
XML multibody description file. The warning message identifies the name of the log file;
the log file identifies the unsupported CAD constraints. In the event a constraint
warning occurs, review the log file and consider replacing the unsupported constraints or
mates with supported equivalents.

The constraint warning does not stop the creation of the XML multibody description file.
You can import the XML file into a new Simscape Multibody model, but the model does
not accurately represent the original CAD assembly. During import, constraint warnings
appear at the MATLAB command line.

For a list of supported constraints, see “Constraints and Joints”.
Correct Constraint Issue

When you import a CAD assembly that contains an unsupported constraint, Simscape
Multibody replaces the constraint with a rigid connection. The connection provides zero
degrees of freedom between the connecting rigid body frames. To restore the original
degrees of freedom between the rigid bodies frames, you must:

+ In the CAD platform, replace each unsupported constraint with a supported
equivalent. When you are finished, export the CAD assembly once again.

* In the imported Simscape Multibody model, manually replace each artificially
introduced rigid connection with the appropriate joint or constraint block.

Note Replacing unsupported constraints with supported equivalents works in a limited
number of cases. In certain cases, no adequate equivalent constraint or joint block exists.
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“Export a SolidWorks Robot Assembly Model” on page 3-2

“Export an Autodesk Inventor Robot Assembly Model” on page 3-7
“Export a PTC Creo Robot Assembly Model” on page 3-11

“Export a Stewart Platform from SolidWorks Software” on page 3-16

“Export a Stewart Platform from Creo Software” on page 3-21
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Export a SolidWorks Robot Assembly Model

In this section...

“Example Requirements” on page 3-3
“Open the Assembly Model” on page 3-4
“Export the Model” on page 3-4

“Check the Exported Files” on page 3-5
“About the Example CAD Files” on page 3-5

“About CAD Export” on page 3-6

In this example, you export a SolidWorks CAD assembly that represents a robot arm.
The export procedure generates one XML file and a set of geometry files that you can
import into Simscape Multibody to generate a new model.

The example begins with a procedure to export the CAD assembly. Information on the
robot CAD files and CAD Export follows the export procedure. To import the robot
assembly into a Simscape Multibody model, see “Import a Robotic Arm CAD Model”
(Simscape Multibody).

The following figure shows the robot CAD assembly you export in this example.
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Example Requirements
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To successfully complete this example, you must meet the following requirements:

* Have the latest version of Simscape Multibody Link installed on your machine.

+ Have completed the linking procedure for your SolidWorks installation. The linking
procedure adds a Simscape Multibody Link add-in to the SolidWorks installation.
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+ Have access to the robot example files that accompany the Simscape Multibody Link
installation. See “Export a SolidWorks Robot Assembly Model” on page 3-2.

Open the Assembly Model

Before you can export the robot assembly, you must load the assembly into SolidWorks.

1  Open SolidWorks on your machine.
2 Select File > Open
3 Navigate to the file directory that contains the robot CAD files.

Note The directory that contains the robot CAD files for the SolidWorks platform is

<MATLAB Root>\toolbox\physmod\smlink\smlinkdemos\...
...solidworks\robot

4  Select file robot . SLDASM.
5 Click Open.

The CAD platform opens the robot assembly.

Export the Model

Once you successfully open the robot CAD assembly in your SolidWorks installation, you
can export the assembly in a format compatible with the latest Simscape Multibody
technology:

1 On the SolidWorks tool bar, select Simscape Multibody Link > Export >
Simscape Multibody. In certain SolidWorks versions, this option may appear
under the Tools menu.

2 Inthe File name field of the Save As dialog box, enter sm_ robot and select a
directory to export the files.

3 Click Save.

Note Large CAD assemblies require more time to complete the export process. Allow
up to a few minutes for the export process to complete.




Export a SolidWorks Robot Assembly Model

Check the Exported Files

Confirm the following files exist in the specified export directory:

+ XML file — provides structure of model and parameters of parts.

+  Geometry files — provides surface geometry of parts.

About the Example CAD Files

The CAD assembly files are present in your Simscape Multibody Link installation. You
can access the files in the following directory:

<MATLAB Root>\matlab\toolbox\physmod\smlink\smlinkdemos\...
...solidworks\robot

Substitute <MATLAB Root> with the root directory of your MATLAB installation.

Note If you are not sure what your MATLAB root directory is, at the MATLAB command
line enter matlabroot. MATLAB returns the root directory for your installation.

The \robot directory contains a set of CAD files that define each CAD part and CAD
assembly. Part file names contain the file extension .SLDPRT. Assembly file names
contain the extension .SLDASM. A drawing file with extension .SLDDRW contains robot
arm dimensions.

The robot assembly contains nine parts and two assemblies: robot.SLDASM and
grip.SLDASM. File robot.SLDASM models the robot root assembly. File grip.SLDASM
models the robot grip subassembly.

The following table lists all files the example requires.

File Name Type
robot.SLDASM Assembly
grip.SLDASM

wrist.SLDPR Part

upperarm.SLDPRT
secondfingerlink. SLDPRT
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File Name Type

metacarples. SLDPRT
firstfingerlinkL.SLDPRT
forearm.SLDPRT
firstfingerlink. SLDPRT
fingertips.SLDPRT
base.SLDPRT

About CAD Export

The CAD export procedure generates one XML multibody description file and a set of
geometry files. The XML file contains the structure of the assembly and the parameters
that define each part. The geometry files define the 3-D geometry of each part. Once the
export procedure is complete, you can import the XML multibody description file into
Simscape Multibody software. Simscape Multibody uses the file to automatically
generate a new Simscape Multibody model.
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Export an Autodesk Inventor Robot Assembly Model

In this section...

“Example Requirements” on page 3-8
“Open the Assembly Model” on page 3-8
“Export the Model” on page 3-8

“Check the Exported Files” on page 3-9
“About the Example CAD Files” on page 3-9
“About CAD Export” on page 3-10

In this example, you export an Autodesk Inventor CAD assembly that represents a robot
arm. The export procedure generates one XML file and a set of geometry files that you
can import into Simscape Multibody to generate a new s model.

The example begins with a procedure to export the CAD assembly. Information on the
robot CAD files and CAD Export follows the export procedure. To import the robot
assembly into a Simscape Multibody model, see “Import a Robotic Arm CAD Model”
(Simscape Multibody).

The Robot Assembly Model
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Example Requirements

To successfully complete this example, you must have:

* Installed the latest Simscape Multibody Link version on your machine.

+  Completed the linking procedure for your Inventor installation. The linking procedure
adds a Simscape Multibody Link add-in to the Inventor installation.

Open the Assembly Model

Before you can export the robot assembly, you must load the assembly into Inventor.

1  Open Inventor on your machine.
2 Select File > Open
3 Navigate to the file directory that contains the robot CAD files.

Note The directory that contains the robot CAD files for the Autodesk Inventor
platform is

<MATLAB Root>\toolbox\physmod\smlink\smlinkdemos\...
. .inventor\robot

4  Select file robot . IAM.
5 Click Open.

The CAD platform opens the robot assembly.

Export the Model

Once you successfully open the robot CAD assembly in your Inventor installation, you
can export the assembly in a format compatible with the latest Simscape Multibody
technology:

In the Inventor toolbar, select Add-Ins > Export > Simscape Multibody.

2 Inthe File name field of the Save As dialog box, enter sm_robot and select a
directory to export the files.

3 Click Save.



Export an Autodesk Inventor Robot Assembly Model

Note Large CAD assemblies require more time to complete the export process. Allow
up to a few minutes for the export process to complete.

Check the Exported Files

Confirm the following files exist in the export directory you specified:

+ XML file—Provides structure of model and parameters of parts.

*  Geometry files—Provide surface geometry of parts.

About the Example CAD Files

The CAD assembly files are present in your Simscape Multibody Link installation. You
can access the files in the following directory:

<MATLAB Root>\matlab\toolbox\physmod\smlink\smlinkdemos\...
...lnventor\robot

Substitute <MATLAB Root> with the root directory of your MATLAB installation.

Note If you are not sure what your MATLAB root directory is, at the MATLAB command
line enter matlabroot. MATLAB returns the root directory for your installation.

The \inventor\robot directory contains a set of CAD files that define each CAD part

and CAD assembly. Part file names contain the file extension .IPT. Assembly file names
contain the extension .JAM.

The robot assembly contains nine parts and two assemblies: robot.IAM and grip.IAM.
File robot.IAM models the robot root assembly. File grip.IAM models the robot grip

subassembly.

The following table lists all files the example requires.

File Name Type
robot.JAM Assembly
grip.JAM

wrist. IPT Part
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File Name Type

upperarm. IPT

secondfingerlink.IPT

metacarples.IPT
firstfingerlink L.IPT
forearm.IPT
firstfingerlink.IPT
fingertips.IPT
base.IPT

About CAD Export

The CAD export procedure generates one XML multibody description file and a set of
geometry files. The XML file contains the structure of the assembly and the parameters
that define each part. The geometry files define the 3-D surface of each part. Once the
export procedure is complete, you can import the XML multibody description file into
Simscape Multibody software. Simscape Multibody uses the file to automatically
generate a new Simscape Multibody model.
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Export a PTC Creo Robot Assembly Model

In this section...

“Example Requirements” on page 3-11
“Open the Assembly Model” on page 3-12
“Export the Model” on page 3-12

“Check the Exported Files” on page 3-13
“About the Example CAD Files” on page 3-14
“About CAD Export” on page 3-15

In this example, you export a Creo (Pro/ENGINEER®) CAD assembly that represents a
robot arm. The export procedure generates one XML file and a set of geometry files that
you can import into Simscape Multibody to generate a new model.

The example begins with a procedure to export the CAD assembly. Information on the
robot CAD files and CAD Export follows the export procedure. To import the robot
assembly into a Simscape Multibody model, see “Import a Robotic Arm CAD Model”
(Simscape Multibody).

The following figure shows the robot CAD assembly that you export in this example.

Example Requirements

To successfully complete this example, you must meet the following requirements:
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* Have the latest version of Simscape Multibody Link installed on your machine.

+  Have completed the linking procedure for your Creo installation. The linking
procedure adds a Simscape Multibody Link add-on tool to the installation.

+ Have access to the robot example files that accompany the Simscape Multibody Link
installation.

Open the Assembly Model
Before you can export the robot assembly, you must load the assembly into Creo.

1 Open Creo on your machine.
2 Select File > Open
3 Navigate to the file directory that contains the robot CAD files.

Note The directory that contains the robot CAD files for the Pro/ ENGINEER
platform is

<MATLAB Root>\toolbox\physmod\smlink\smlinkdemos\proe\robot

4  Select file robot . ASM.
5 Click Open.

The CAD platform opens the robot assembly.

Export the Model

Once you successfully open the robot CAD assembly in your Creo installation, you can
export the assembly in format:

1 In the Creo toolbar, click Tools.

2 Select Simscape Multibody Link > Export and click Simscape Multibody to
export in a format compatible with the latest Simscape Multibody technology.

3 In the File name field of the Select Folder dialog box, enter select a directory to
export the files into.

Note Do not enter a name in the File name field. The field should contain only a
dot .




Export a PTC Creo Robot Assembly Model

Click Open.

In the new dialog box, enter file name sm robot and click the green arrow.

Note Simscape Multibody Link generates a new XML multibody description file and
a set of geometry files that you can import into a model.

Check the Exported Files

Confirm the following files exist in the export directory you specified:

XML Multibody Description File

Name

Type

Description

sm_robot.xml

XML multibody description
file

The XML file defines the
structure of the CAD
assembly. The file also
contains the parameters

required to model each part
in the CAD assembly.

Geometry Files

Note In the Name column, <identifier> is a set of numeric and alphabetic characters

that identifies each file.

Name

Type

Description

base_prt

fingertips_prt

firstfingerlink_prt

firstfingerlinkl_prt

forearm_prt

metacarples_prt

secondfingerlink_prt

upperarm_prt

Geometry files

Provide the 3-D surface
shapes of the CAD parts
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Name Type Description

wrist_prt

About the Example CAD Files

The CAD assembly files are present in your Simscape Multibody Link installation. You
can access the files in the following directory:

<MATLAB Root>\matlab\toolbox\physmod\smlink\smlinkdemos\...
...proe\robot

Substitute <MATLAB Root> with the root directory of your MATLAB installation.

Note If you are not sure what your MATLAB root directory is, at the MATLAB command
line enter matlabroot. MATLAB returns the root directory for your installation.

The \proe\robot directory contains a set of CAD files that define each CAD part and

CAD assembly. Part file names contain the file extension .PRT. Assembly file names
contain the extension .ASM.

The robot assembly contains nine parts and two assemblies: robot. ASM and grip.ASM.
File robot. ASM models the robot root assembly. File grip.ASM models the robot grip

subassembly.

The following table lists all files the example requires.

File Name Type

robot Assembly

grip

wrist Part

upperarm

secondfingerlink

metacarples

firstfingerlinkLL

forearm
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File Name Type

firstfingerlink

fingertips

base

About CAD Export

The CAD export procedure generates one XML multibody description file and a set of
geometry files. The XML file contains the structure of the assembly and the parameters
that define each part. The geometry files define the 3-D surface shapes of the CAD parts.
Once the export procedure is complete, you can import the XML multibody description
file into Simscape Multibody. Simscape Multibody uses the file to automatically generate
a new Simscape Multibody model.
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Export a Stewart Platform from SolidWorks Software

In this section...

“Example Requirements” on page 3-16
“Open the Assembly Model” on page 3-17
“Export the Model” on page 3-17

“Check the Exported Files” on page 3-18
“About the Example CAD Files” on page 3-20
“About CAD Export” on page 3-20

In this example, you export a SolidWorks CAD assembly that represents a Stewart
platform. The export procedure generates one XML file and a set of geometry files that
you can import into Simscape Multibody to generate a new model.

The example begins with a procedure to export the CAD assembly. Information on CAD
files and CAD Export follows the export procedure. To import the robot assembly into a
Simscape Multibody model, see “Import a Robotic Arm CAD Model” (Simscape
Multibody).

The following figure shows the Stewart platform assembly you export in this example.

Example Requirements

To successfully complete this example, you must meet the following requirements:
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Have the latest version of Simscape Multibody Link installed on your machine.

Have completed the linking procedure for your SolidWorks installation. The linking
procedure adds a Simscape Multibody Link add-in to the SolidWorks installation.

Have access to the Stewart Platform example files that accompany the Simscape
Multibody Link installation. See “About the Example CAD Files” on page 3-20.

Open the Assembly Model

Before you can export the robot assembly, you must load the assembly in a SolidWorks

session.

1  Open SolidWorks on your machine.

2 Select File > Open

3 Navigate to the file directory that contains the robot CAD files.
Note The directory that contains the robot CAD files for the SolidWorks platform is
<MATLAB Root>\toolbox\physmod\smlink\smlinkdemos\...
...solidworks\stewart

4  Select file stewart platform.SLDASM.

5 Click Open.

The CAD platform opens the Stewart platform assembly.

Export the Model

Once you successfully open the CAD assembly in your SolidWorks installation, you can
export the assembly in a format compatible with the latest Simscape Multibody
technology:

1

In the SolidWorks toolbar, select Simscape Multibody Link > Export and click
Simscape Multibody . In certain SolidWorks versions, this option may appear
under the Tools menu.

In the File name field of the Save As dialog box, enter sm_stewart platformand
select a directory to export the files.

Click Save.
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Note Large CAD assemblies require more time to complete the export process. Allow
up to a few minutes for the export process to complete.

You can proceed to import the robot assembly into a Simscape Multibody model. See
“Import a Robotic Arm CAD Model” (Simscape Multibody).

Check the Exported Files

Confirm the following files exist in the specified export directory:

XML Multibody Description File
Name Type Description

sm_stewart_platform.xml |XML multibody description |Provides the assembly

file structure and part
parameters that define the
CAD assembly

Geometry Files

Name Type Description
BaseRing_Default_sldprt Geometry files Provides the 3-D surface
Bearing_Block_Default_sldp shapes of the various CAD
o parts

Carrier_Block_Default_sldp
rt

CenterBlock_Default_sldprt

CeramicStrip5010_Default_
sldprt

Clevis_pin_A_3x6_Default_s
1dprt

Cylinder_Head_Cap_Screw_
M3x10_Default_sldprt

Cylinder_Head_Cap_Screw_
M3x8_Default_sldprt

DialPlate2_Default_sldprt

3-18



Export a Stewart Platform from SolidWorks Software

Name

Type

Description

GratingStrip5010_Default_s
1dprt

HR_1_Motor_Default_sldprt

Hex_Nut_M5_Default_sldpr
t

Hexagon_Socket_Button_He
ad_Screw_M3x6_Default_sl
dprt

Hexagon_Socket_Head_Cap
_Screw_M3x5_Default_sldp
rt

Hexagon_Socket_Set_Screw
_M3x3_Default_sldprt

MPB_C345MB_Default_sld
prt

RGH25_Default_sldprt

Recessed_Pan_Head_Screw
_M2x8_48_7_Default_sldprt

RenishawMount_Default_sl
dprt

SV2075_Default_sldprt

ShaftStop_Default_sldprt

Spider_Default_sldprt

Threaded_Shaft Default_sl
dprt

Yoke_Default_sldprt

pin2_Default_sldprt

stewart_platform
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About the Example CAD Files

The CAD assembly files are present in your Simscape Multibody Link installation. You
can access the files in the following directory:

<MATLAB Root>\matlab\toolbox\physmod\smlink\smlinkdemos\...
...solidworks\stewart

Substitute <MATLAB Root> with the root directory of your MATLAB installation.

Note If you are not sure what your MATLAB root directory is, at the MATLAB command
line enter matlabroot. MATLAB returns the root directory for your installation.

The \stewart directory contains a set of CAD files that define each CAD part and CAD
assembly. Part file names contain the file extension .SLDPRT. Assembly file names
contain the extension .SLDASM.

About CAD Export

The CAD export procedure generates one XML multibody description file and a set of
geometry files. The XML file contains the structure of the assembly and the parameters
that define each part. The gemoetry files define the 3-D surface shapes of the various
CAD parts. Once the export procedure is complete, you can import the XML multibody
description file into Simscape Multibody software. Simscape Multibody uses the file to
automatically generate a new Simscape Multibody model.
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Export a Stewart Platform from Creo Software

In this section...

“Example Requirements” on page 3-22
“Open the Assembly Model” on page 3-22
“Export the Model” on page 3-22

“Check the Exported Files” on page 3-23
“About the Example CAD Files” on page 3-24
“About CAD Export” on page 3-25

In this example, you export a Stewart platform assembly from a Creo (Pro/ENGINEER)
CAD platform. The export procedure generates one XML file and a set of geometry files
that you can import into Simscape Multibody to generate a new model.

The example begins with a procedure to export the CAD assembly. Information on CAD
files and CAD Export follows the export procedure. To import the robot assembly into a
Simscape Multibody model, see “Import a Robotic Arm CAD Model” (Simscape
Multibody).

The following figure shows the Stewart platform assembly you export in this example.
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Example Requirements

To successfully complete this example, you must meet the following requirements:

*  Have the latest version of Simscape Multibody Link installed on your machine.

+  Have completed the linking procedure for your Creo installation. The linking
procedure adds a Simscape Multibody Link add-in to the Creo installation.

* Have access to the Stewart Platform example files that accompany the Simscape
Multibody Link installation. See “About the Example CAD Files” on page 3-24.

Open the Assembly Model

Before you can export the robot assembly, you must load the assembly in a Creo session.

1 Open Creo on your machine.
2 Select File > Open
3 Navigate to the file directory that contains the robot CAD files.

Note The directory that contains the robot CAD files for the Creo platform is

<MATLAB Root>\toolbox\physmod\smlink\smlinkdemos\proe\stewart

Select file stewart platform.ASM.
Click Open.

The CAD platform opens the Stewart platform assembly.

Export the Model

Once you successfully open the CAD assembly in your Creo installation, you can export
the assembly in format:

1 In the Creo toolbar, select Simscape Multibody Link > Export and click
Simscape Multibody.

2 In the File name field of the Select Folder dialog box, enter select a directory to
export the files into.
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Note Do not enter a name in the File name field. The field should contain only a
dot .

3 Click Open.

4 In the new dialog box, enter file name sm stewart platform and click the green
arrow.

Note Simscape Multibody Link generates a new XML multibody description file and
a set of geometry files that you can import into a model.

You can proceed to import the robot assembly into a Simscape Multibody model. The
import model assumes the XML multibody description file you generated in this example
has the name sm_stewart platform.xml.If the file has a different name, change the
name to sm_stewart platform before proceeding. See “Import a Robotic Arm CAD
Model” (Simscape Multibody).

Check the Exported Files

Confirm the following files exist in the specified export directory:

XML Multibody Description File

Name Type Description
sm_stewart_platform XML multibody description |Provides the assembly
file structure and part

parameters that define the
CAD assembly

Geometry Files

Name Type Description
ai_f100128_prt Geometry files Provides the 3-D surface
shapes of the various CAD

basering_prt

- parts
bearing_block_prt

carrier_block_prt

centerblock_prt

ceramicstrip5010_prt
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Name Type Description

clevis_pin_a_3x6_prt

cylinder_head_cap_screw_m
3x8_prt

cylinder_head_cap_screw_m
3x10_prt

dialplate2_prt

gratingstrip5010_prt

hex_nut_m5_prt

hexagon_socket_button_hea
d_scre_prt

hexagon_socket_head_cap_s
crew_m_prt

hexagon_socket_set_screw_
m3x3_prt

hr_1_motor_prt

mpb_c345mb_prt

pin2_prt

recessed_pan_head_screw_
m2x8_48 prt

renishawmount_prt

rgh25_prt

shaftstop_prt

spider_prt
sv2075_prt
threaded_shaft_prt
yoke_prt

About the Example CAD Files

The CAD assembly files are present in your Simscape Multibody Link installation. You
can access the files in the following directory:
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<matlabroot>\matlab\toolbox\physmod\smlink\smlinkdemos\...
...proe\stewart

Substitute <matlabroot> with the root directory of your MATLAB installation.

Note If you are not sure what your MATLAB root directory is, at the MATLAB command
line enter matlabroot. MATLAB returns the root directory for your installation.

The \stewart directory contains a set of CAD files that define each CAD part and CAD
assembly. Part file names contain the file extension .PRT. Assembly file names contain
the extension .asm.

About CAD Export

The CAD export procedure generates one XML multibody description file and a set of
geometry files. The XML file contains the structure of the assembly and the parameters
that define each part. The geometry files define the 3-D geometry of each part. Once the
export procedure is complete, you can import the XML multibody description file into
Simscape Multibody software. Simscape Multibody uses the file to automatically
generate a new Simscape Multibody model.

3-25






Custom Linking to Third-Party
Applications

The Simscape Multibody Link software includes an application programming interface
(API). With the API of an external application program and the Simscape Multibody

Link API, you can selectively transfer data from the external application to the Simscape
Multibody Link software.

“Custom Export with Simscape Multibody Link API” on page 4-2
“Custom Translation into an XML Multibody Description File” on page 4-6
“Design Custom Exporter Module” on page 4-11

“Program Custom Exporter with Simscape Multibody Link API” on page 4-15
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Custom Export with Simscape Multibody Link API

In this section...
“About Custom CAD Export” on page 4-2

“Custom Translation Steps in Common with Standard Export” on page 4-3

“Custom Translation Steps Different from Standard Export” on page 4-4

“Requirements for Creating a Custom Exporter” on page 4-4

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About Custom CAD Export

The translation process from an externally defined machine representation to a Simscape
Multibody model is the same whether you use the standard export with a supported
external third-party platform or create your own custom exporter. The Simscape
Multibody Link exporter translates mechanical system data from an external
application, such as a computer-aided design (CAD) platform. You can use this
translated data to generate a Simscape Multibody model of your original mechanical
system.

SimMechanics
model

«
oy
S
| | ST fle(s) g Machine

| visualization
.

CAD assembly SimMechanics Link & SimMechanics

Reasons for Custom CAD Export

You must create and use your own custom exporter when:

* You want to export an assembly from a CAD platform that the Simscape Multibody
Link utility does not support.

4-2




Custom Export with Simscape Multibody Link API

The standard export from a supported CAD platform does not yield the results that
you want.

Prerequisites for Custom CAD Export

CAD translation includes CAD assembly export and Simscape Multibody model import.
Export requires:

A CAD platform or application, including access to its application programming
interface (API)

MATLAB installed and registered as a server

The Simscape Multibody Link utility, which includes its own API

A custom exporter module that you create and that transfers assembly information
from the CAD platform API to the Simscape Multibody Link API

Import requires Simscape Multibody software.

Custom Translation Steps in Common with Standard Export

You generate Simscape Multibody models from XML multibody description files. You use
mechanical import and then visualize the models with geometry files in STEP or STL
format. Custom export creates an XML file to represent a CAD assembly and a set of
geometry files to represent the surface geometries of the assembly bodies. This part of
CAD translation is the same as standard export.

Physzical Modeling
XML file

SimMechanics

SimMechanics model

v

(MATLAB s Simulink & Simscape

S
STL file(s) _.,J Machine

| visualization
L

From an XML multibody description file to a Simscape Multibody Model

4-3



4 Custom Linking to Third-Party Applications

Custom Translation Steps Different from Standard Export

For custom export, you must create a custom exporter module that interacts with the
APIs of both the CAD platform and the Simscape Multibody Link utility. From a CAD
assembly, this custom exporter module creates a selective, intermediate representation of
the machine that persists for one session. The module then finishes by creating the same

files as the standard export does:

*  An XML multibody description file representing selected data required to generate a
Simscape Multibody model, which is written from the selective representation

+ A set of geometry files to represent the surface shapes of the assembly bodies

e Custom Export Process e

CAD aszembly

CAD Platform

Custom Export: From a CAD Assembly to an XML Multibody Description File
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Custom
Exporter

SimMechanics

STL files

Requirements for Creating a Custom Exporter

Physical Modeling
XML file

Note The Simscape Multibody Link API is supported on all platforms that MATLAB

supports.

To create a custom exporter:

* Access the API of your CAD platform and understand how to call it from an external

program. See your CAD platform documentation.

* Access the Simscape Multibody Link API and understand how to call it from an

external program.



Custom Export with Simscape Multibody Link API

*  Write the custom exporter module in C/C++.

The module might be an executable or a linked library, depending on your CAD
platform requirements and API.

For more information, see “Custom Translation into an XML Multibody Description File”
on page 4-6
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Custom Translation into an XML Multibody Description File

In this section...
“Mapping API Objects from CAD to XML” on page 4-6
“Selecting CAD Assembly Data for Export” on page 4-8

“Constructing Intermediate API Representations” on page 4-8

“Converting Selective API Representations into XML” on page 4-10

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Mapping API Objects from CAD to XML

A complete CAD assembly contains information both relevant and not relevant for
exporting an XML multibody description file to represent your assembly.

ST
C —————
A | @ctected caTy ||| s —— — — —
Selected CAD
- | assembly data | - Intermediate SimMechanics
CAD assembly [— —P| bie SimMechanies Link Link API
A as object or I API object | 1
p | data structure | —
1 [

| Physical Modeling
STL files XML file

For detailed information on the design of a custom export module, see section “Design
Custom Exporter Module” on page 4-11.

Data Required from a CAD Assembly to Create a Simscape Multibody Model
You obtain the selected assembly data through the CAD platform application

programming interface (API) in the form of an object or a data structure. The data
required from an assembly to construct a Simscape Multibody model include:
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Mapping of Selected Mechanical Data to Simscape Multibody Model Components

Data Selected from CAD Assembly or Other |...Required Simscape Multibody Model
External Machine Definition Mapped to... Component

Assembly and parts origin Ground and World coordinate system
Assembly and subassembly hierarchy Model and subsystem hierarchy

Part masses and inertia tensors, colors, Bodies, including their mass properties,

and body geometry file names geometries, and colors

Constraint restrictions on relative Joints between pairs of Bodies

positions and motions of parts Body coordinate systems connected to Joints

Using the Exporter Functions to Complete the Mapping of CAD to XML

Refer to the table Mapping of Selected Mechanical Data to Simscape Multibody Model
Components. Using your CAD exporter module, you transform the selected data listed in
the first column of the table into the form required in the second column with the
Simscape Multibody Link API functions and data types. You collect the selected data into
an intermediate Simscape Multibody Link APT object. With the Simscape Multibody Link
API, you then write the intermediate API representation to an XML multibody
description file.

See “Design Custom Exporter Module” on page 4-11 for information on these API
functions and data types.

Body Geometry Files Exported Directly from CAD API

For each moving Body in the model, the final Simscape Multibody model requires a
separate body geometry file in STEP or STL format. You export these body geometry files
directly from the CAD API, with file names matching the body geometry file names
specified in the exported XML file. You specify these file names in the Simscape
Multibody Link API object.

Tip You need body geometry files only for individual moving CAD parts or rigid
subassemblies, not for flexible subassemblies.
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Selecting CAD Assembly Data for Export
Tracing the Assembly Hierarchy: Nodes and Components

The assembly data that you need to retrieve through the CAD API starts with the
assembly-subassembly hierarchy, with nodes. Each node in the hierarchical tree is an
assembly component (a part or a subassembly).

For an individual component, the next component immediately up in the hierarchy is its
parent. All dependent components connected below in the hierarchy are its children. The
top parent in the assembly hierarchy is the whole assembly itself.

Identifying and Extracting Component Information

For each component, determine:

+ Its geometric transformation with respect to its parent, its mass, its inertia tensor, its
body geometry and color (for a part, or for a rigid subassembly exported as a single
rigid body)

* The constraints that restrict how its children can move with respect to each other

*  Whether or not the component is rigid or flexible; that is, whether all its children are
to be treated as a single rigid body or as individual moving bodies

*  Whether or not the component is fixed; that is, whether it is rigid or moving with
respect to its parent

Constructing Intermediate API Representations

Before you can export the CAD assembly, you must construct a selective intermediate
CAD representation, a collection of objects that capture the required CAD data.

Objects Required for Intermediate Representations

+ CAD models (not to be confused with CAD assemblies or Simscape Multibody models).
These represent assemblies, subassemblies, and parts.

+  CAD model references

+  Components (parts or subassemblies)

+ Constraints

+ A translator object constructed from all the other objects
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Putting Objects Together into Intermediate Representations

To construct a full CAD representation:

1
2

Represent the entire assembly with a CAD model object.
Represent child parts and subassemblies with additional CAD model objects.

If a subassembly is flexible (its parts can move with respect to each other), the
subassembly 1s a parent to child parts, represented by their own CAD model objects.

Add child CAD model reference objects to their parent CAD model objects, including
parent-to-child transforms.

You might need to repeat steps 1 through 3 recursively until you have mapped the
entire CAD assembly hierarchy.

Represent constraints between components with constraint objects. These are also
children to parent assembly and subassembly objects.

Form a single translator object from all these objects, referenced by one another in a
hierarchy that parallels the original assembly hierarchy.
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CAD Assembly | | CAD Model Object: Assembly |
Partl component | CAD Mode! Ref Object: Partl |
Part? component | CAD Model Ref Object: Part2 |
Relationships
_T_| PartAl component | -T-l CAD Model Ref Object: PartAl |
—— " Parta2 component | I CAD Model Ref Object: Parta? |
—%—{  PartA3 component | H4-{ CAD Model Ref Object: Parta3 |
|| | E——] :
Constraint
PartB1 component _| TI CAD Mode! Ref Object: PariB1 | RE‘Ia“OHSh‘pSl
PartB2 component | -LI CAD Model Ref Object: PartB2 |
CAD Assembly Intermediate API Representation

CAD Assembly and Intermediate API Representation: Parallel Hierarchies

Converting Selective API Representations into XML
The final translator object is the last intermediate form of the CAD assembly translation.

From this translator object, you create the XML multibody description file representing
the assembly.
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Design Custom Exporter Module

In this section...

“Prerequisites for Custom Exporter Modules” on page 4-11

“Implementing Translation with CAD and Simscape Multibody Link APIs” on page 4-
12

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Prerequisites for Custom Exporter Modules

A custom exporter module works with intermediate representations of CAD assembly
data. For an overview of the types of CAD assembly and Simscape Multibody Link data
and their relationship, see “Custom Translation into an XML Multibody Description File”
on page 4-6.

A custom exporter module:

Issues function calls to the APIs of both the CAD platform and the Simscape
Multibody Link utility.

Transfers assembly representation data from the assembly, through the CAD API, to
the XML multibody description file, through the Simscape Multibody Link API.

Funection

Funection

Cusztom
Exporter
Module (C/C++)

SimMechanies
Link APT

Platform
API

Custom Exporter Module Communicates with APIs (Detail)
Using the Simscape Multibody Link API Functions

The Simscape Multibody Link API is a library of API functions that you call to construct
a unified, selective representation of an assembly and write it as an XML file. “Program
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Custom Exporter with Simscape Multibody Link API” on page 4-15 describes how to
create, compile, and execute custom exporter modules in C/C++ with the Simscape

Multibody Link API function library.

Implementing Translation with CAD and Simscape Multibody Link APIs

Extracting Selective CAD Assembly Data

To extract the selected assembly data required for export, consult your CAD platform

API documentation and determine which functions of the CAD platform API you need to

accomplish this.

Constructing the Intermediate APl Representation

To construct the intermediate representation of an assembly, use the following functions
from the Simscape Multibody Link API, in the order shown. The API also contains other

functions you might need in special cases. For more information, consult the Simscape

Multibody Link Reference documentation.

To... Use Simscape Multibody Link
API Function...
Set length and mass pmit set units

units for CAD assembly.
The defaults are meters
(m) and kilograms (kg),

respectively.

a. Create CAD model pmit create cadmodel
object to contain data for
CAD assembly

b. Create API pmit create cad2sm
representation
translator object

Set translational, pmit set tolerances
rotational, and

numerical tolerances for
CAD assembly

a. Create object to pmit create cadmodel
contain data for CAD
subassemblies and parts

...and Simscape Multibody
Link API Objects

PmitCadModelH

PmitCad2SMH

PmitCad2SMH

PmitCadModelH
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Step

Step

To...

b. Create reference to
CAD model object

c. Add reference within
existing CAD model
object to child model
object by adding
transform

a. Create object to
contain data for CAD
assembly component
(part or rigid
subassembly)

b. Add reference within
existing CAD model
object to child assembly
component object

a. Create object to
contain data for
constraint between CAD
components (parts or
rigid subassemblies)

b. Add constraint object
to CAD model object

Use Simscape Multibody Link
API Function...

pmit create cadmodelref

pmit add refincadmodel

pmit create assemcomp

pmit add refincomp

pmit create constrain

pmit add constrain

Export Intermediate APl Representation into XML

...and Simscape Multibody
Link API Objects

PmitCadModelH,
PmitCadModelRefH

PmitCadModelH,
PmitCadModelRefH

PmitAssemCompH

PmitAssemCompH,
PmitCadModelRefH

PmitAssemCompH,
PmitConstrainH,
PmitConstrainType,
PmitGeomType

PmitCadModelH,
PmitConstrainH

To export the selective representation of your assembly into an XML multibody
description file, use the following functions from the Simscape Multibody Link API, in

the order shown.

To...

Use Simscape Multibody Link
API Function...

Enable the translation of pmit create cad2sm
CAD assembly data into a
Simscape Multibody model

...and Simscape Multibody Link
API Objects

PmitCad2SMH
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Step
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To... Use Simscape Multibody Link ...and Simscape Multibody Link
API Function... API Objects
Write an XML multibody pmit write xml PmitCad2SMH

description file from
selective CAD
representation of assembly

For detailed information on the programming of a custom export module with the

Simscape Multibody Link API, see “Program Custom Exporter with Simscape Multibody
Link API” on page 4-15
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Program Custom Exporter with Simscape Multibody Link API

In this section...

“Including, Linking to, and Calling the API Function Library” on page 4-15
“Locating API Code Examples” on page 4-16

“A Custom Exporter Module Example” on page 4-16

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Including, Linking to, and Calling the API Function Library

In the following procedures, replace:

* matlabroot with the root of your MATLAB installation.

* ARCH with the specific operating system architecture abbreviation for your system (for
example, win64 for 64-bit Windows).

Including and Using the API Header File

To write your C/C++ custom exporter module, use the C header file located in
matlabroot/toolbox/physmod/smlink/api/include/.

This header file contains the function definitions that you follow to call the Simscape
Multibody Link API functions from your module. Include this header file in your module
C/C++ source code.

Compiling and Linking the Custom Exporter Module
In addition to linking your custom module to the Simscape Multibody Link API, consult

your CAD platform's API documentation to determine requirements for linking to the
platform's API.

On Windows Platforms

After you compile your module, link it to the binary API function library located in
matlabroot\toolbox\physmod\smlink\api\lib\.
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On UNIX, LINUX, and Mac Platforms

After you compile your module, link it to the binary API function library:
matlabroot/bin/ARCH/libmwpmi api.0S-SPECIFIC-EXTENSION
0S-SPECIFIC-EXTENSION is the API file extension specific to your operating system.
Executing the Custom Exporter Module

To determine if you need to include your CAD platform API on the path, consult your
CAD platform API documentation.

On Windows

Before you start execution of the module, verify that the folder matlabroot\bin\ARCH\
is on the path.

On UNIX, LINUX, and Mac Platforms
Before you start execution of the module, verify that the folder matlabroot/bin/ARCH/

is included in the system path environment variable LD LIBRARY PATH.

Locating APl Code Examples

You can find API examples in this folder:

matlabroot/toolbox/physmod/smlink/api/example/

The subfolder, cadapi example/, contains CAD-based examples.

A Custom Exporter Module Example

The folder matlabroot/toolbox/physmod/smlink/api/example/
cadapi example/ contains a simple C++ example of a custom module based on the API,
cadapi_ example.cpp.

* The example custom module converts two CAD parts with one constraint into two
Simscape Multibody bodies and one joint and then writes the result to an XML file.

* The example program defines the CAD assembly data internally, rather than taking
the data from a CAD platform through the platform API. Compared to the figure
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“Custom Exporter Module Communicates with APIs (Detail)” on page 4-11, the
leftmost portion of the diagram is missing.

To extend the example module to process real assembly data, add code that calls a
CAD platform's API for assembly data to replace the internally defined data.
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